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The SkiRaceReg.com service was launched for the 2010-2011 competition season to provide online 
race registration and entry fee payment processing services for USSA masters divisions.  A principal 
objective of the system is to provide easy-to-use interoperability with the USSA Alpine Race Scoring 
Software produced by Split Second Timing (http://www.splitsecond.com). 
 
The information provided here supplements the Split Second user documentation by describing 
recommended procedures and tips for using the software most effectively for running a USSA masters 
race. 
 
You should be working with version 6.24 of the Split Second National/FIS timing software for the 2012 
season to take advantage of the features and suggestions provided here.  If you are working with 
different timing system software, the specific procedures described here are not directly applicable, 
although some of the general approaches may be useful to consider. 
 
The material that follows discusses the operations involved in downloading competitor entries from the 
SkiRaceReg.com registration site into a Split Second race file as part of creating the race data file for 
an event and uploading the race results data back to the registration system at the completion of the 
event for processing competitor entry fee charges. 
 
For questions and comments about the material in this document, contact Deb Lewis, the Director of 
Race Services and Scoring for the Far West Masters, at dlewis@farwestmasters.org.  Additional 
information about Alpine Masters can be obtained from USSA, Split Second, and the ussamasters.org 
web site. 
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Introduction	  
 
The SkiRaceReg.com site provides online registration services for alpine masters ski races.  
Competitors can open an account of the registration system and submit their race entries through the 
site.  Competitor entries are downloaded from the web site and imported into the Split Second Timing 
software to prepare the competitor list for an event.  Following the race, the Split Second results file is 
uploaded back to the registration system so that entry fees can be charged against the credit cards 
registered for a racer account. 
 
###TODO: add processing flow diagram here### 
 
The entry list data file downloaded from SkiRaceReg.com includes the standard competitor entry 
values, equivalent to the values entered for competitors entered manually and pulled from the points 
list file from USSA (name, year born, gender, USSA license number).  For divisions that assign 
permanent bib numbers to their members, the entry file will also include the racer’s bib number.   
 
The SkiRaceReg.com site also provides USSA license checks to verify whether the competitor’s 
masters license is paid for the current season and includes fields in the entries download file which 
indicate competitors who were not found in the current season license list.  The ussa-paid values assist 
the Race Administrator (RA) by identifying competitors who need to obtain an Alpine Masters 
competitor license for the current season or purchase a 1-time weekend license for the event.  A USSA 
temporary license can be purchased for $25 once per season; the amount paid can subsequently be 
credited towards purchase of an Alpine Masters competitor license. 
 
(back to Contents) 
 

General	  Settings	  in	  Split	  Second	  
 
• Make sure you are using the current version of Split Second Timing, National/FIS version 
 
You should be using version 6.24 of the National/FIS alpine software.  Use the Help/About menu 
command to check your version; visit http://splitscond.com to check for availability of a newer version 
(usually not necessary, Split Second will generally prompt you when the program is started when there 
is a newer version available for download). 
 
• Make sure your race file is set up as a masters race 
 
On the Header page in Split Second, the Discipline choice must be Masters Alpine. The Race Level 
should be USSA; the Scored checkbox should not be selected - masters races are non-scored events on 
the USSA calendar. 
 
Enter the pair of USSA race codes for M/F that were assigned when your schedule agreements were 
processed by USSA to obtain sanctioning on the USSA calendar.  USSA requires separate calendar 
agreements and race codes for each gender, even though most masters competitions are held as a single 
race with both genders competing in their age classes on a single course. 



 
• Make sure you have the current masters points list file 
 
On the Factors/List page in Split Second,  use the Download operation to ensure that you have the 
most recent masters points list file available.  Select the current points list, along with the current 
officials list. 
 
###TODO: add note about officials points list bug in masters; you have to download from an Alpine 
race, then go into the Split Second data files folder and copy from Points List folder into the Masters 
sub-folder 
 
• Turn off autosort [IMPORTANT!!] 
 
Open the Options dialog from the Edit menu and make sure the “Automatically Sort when generating 
reports” option is NOT selected (not checked)!!!  There are usually a number of scenarios where you 
want to prepare your competitor list order manually, so you do not want running a report to wipe out 
your work!! You will be prompted when you run a report when this option is turned off, so you can 
always allow Split Second to perform its standard sort for the report you are creating if that’s what you 
want, but turning this option off lets you be in control. 
 
(back to Contents) 
 
 

Create	  a	  Folder	  for	  SkiRaceReg.com	  Data	  Files	  
 
To help keep track of the files you will be exchanging with SkiRaceReg.com to download competitor 
entries and upload race results, create a folder in a standard location that is easy for you to find and 
remember. 
 
Depending on what you are accustomed to doing, we recommend that you create the new folder either 
on your Windows desktop or in your Windows Documents folder (available from the Start menu).   
 
Use the standard New Folder operation to create the folder and name it “SkiRaceReg Files”. 
 
(Note for experts: If you are comfortable working with the file system, you could also create your 
SkiRaceReg folder directly in the SplitSecond/NationalFIS data directory.) 
  
(back to Contents) 
 



 

Preparing	  Race	  Files	  and	  Downloading	  Entries	  from	  SkiRaceReg.com	  
 
The basic procedure is that you will create a master entry file for your event so you have a single race 
file in which you will enter all competitors who registered “offline” by sending a print entry form and 
payment directly to the organizer.  A typical masters event occurs on a weekend and has two or more 
races.  Bib assignments should be made in the master file.  You will then make a copy of the master 
file for each race that you are running and download competitor entries from the online registration 
system into each race file. 
 

Create a Master Entry File for your Event 
 
Create a Split Second race for your event – call it something like “My Event – MASTER” or  “My 
Event – REGISTRATION” to remind yourself that this is the master entry list for competitor entries 
received directly by the organizer (“offline” print entries with payment directly to the organizer).  Be 
sure to put this name in the Race Name field of the Header page in Split Second so that the race name 
displayed in the program is consistent with the file name. 
 
As described in the General Settings section above, make sure your race is set up as an Alpine 
Masters race and that you have the latest masters points list installed.  Enter all competitors for whom 
you have a print entry form in the master registration file, in the usual fashion.  In most cases 
competitors should come up automatically from the points list data; you will only need to do manual 
entry of name/YOB/gender values if the competitor is new or has not purchased their USSA masters 
license for the current season. 
 
Where appropriate, feel free to make notes about any special considerations for each race (e.g., needs 
license, only entered in a single race, etc). 
 
Use the membership report provided by the division to enter the racer’s bib number, if permanent bibs 
are used (e.g. Far West Masters).  For any racer without a permanent bib number, assign a weekend bib 
number. 
 
(For Far West Masters, we will provide list of available 900+ temp bib numbers to be assigned to new 
racers or competitors who have not paid their Far West Masters season dues to obtain a permanent 
bib number) 
 

Copy the Master Entry File for each Race 
 
After online registration on SkiRaceReg.com has closed (typically by the day prior to the start of the 
event) and all offline competitor entries have been entered in the master registration file, make a 
separate copy of the master file for each race that you will be running.   
 
Use the Save As operation in the File menu of Split Second to make the race files.  Assuming your 
master entry file is called something like “MyEvent-Master”, use a consistent naming convention for 
your race files – e.g., MyEvent-race1, MyEvent-race2 or MyEvent-Sat, MyEventSun. 



 
In the race file copied from the master, update the Race Name on the Header page to indicate which 
race.  Check/update the discipline and the race date.  Enter the M/F race codes from USSA for this 
race. 
 
Return to your master entry race (use File/Open menu command) and repeat this for each race, e.g. do 
once for your Saturday race and repeat the process for the Sunday race of a weekend event. 
 

Download Entries from SkiRaceReg.com and Import into the Race File 
 
For each separate race, you will download and import competitor entries from the online registration 
system into the Split Second data file for that race.  
 
To download the online competitor entries, log into the SkiRaceReg.com web site with your RA 
account.  Select Races from the choices in the Administration menu at the far right of your window.  
For each of your races, locate the race in the listing page and click the download link in the Actions 
column (below the registrations link that displays a page showing the registered competitors and the 
upload and import link that you will use for post-race payment processing).   
 
A small popup window will appear which displays the race name and a download link that you should 
click on to download the competitor entry list to your computer.  The download operation prompts you 
to confirm that you have asked to save a file from SkiRaceReg.com.  Click on the Save File button to 
continue.  You will be asked where you wish to save the file, with a name that will be something like 
register_myevent_race1.csv – locate the SkiRaceReg Files folder that you created during your setup 
and save the file there.  Click Close in the download window when you are done. 
 
Repeat for each race, so that you have a register_* file for each separate race  in your SkiRaceReg 
Files folder. 
 
Open your race in Split Second and use the Import operation in the File menu to do “Import from any 
Comma or Tab separated file”.  In the Import From… dialog, locate your SkiRaceReg Files folder and 
select the registration download file for the race you are working on. 
 
In the Split Second Import dialog, first check the settings: choose comma delimited format, detect 
duplicates By USSA or FIS number.  For the duplicate handling option, select Don’t overwrite when 
find a duplicate.  
 
(You should not ordinarily encounter duplicates – if any are reported you will need to identify and 
reconcile whether payment has been received because the competitor came from your offline entries 
master file or whether the online entry should be added so that the competitor will be charged through 
SkiRaceReg.com payment processing.  Contact your masters division raceadmin for assistance in 
handling this case if you encounter) 
 
Select ‘0” in the Lines to Ignore  choice so that the import preview area at the bottom of the Import 
window shows the first row of the online registrations data file that you are importing – this row 
contains labels describing the value in each column and is used to ensure that your column import 
mappings are set up correctly to load into Split Second. 



 
Use the “Used for” choice for each column at the right side of the Import window to ensure that the 
registration file values are loaded into the appropriate field in the Split Second data file.  The Preview 
area shows the column number along with the Split Second field the value will be loaded into or ‘—‘ if 
the column will be ignored.  The labels in the first row of the data file generally correspond to the Split 
Second field names to help ensure that it’s easy to set up the import mappings correctly.  Use the table 
below as your checklist for the import settings; when you are done, compare the field name with the 
first row of the data to ensure you have everything loaded in the correct order. 
 
Column SRR Label SST Field Rqrd Notes 
1 Bib Bib yes * Bib (used if division assigns bibs) 
2 Club Club/Quota optional optional team name (RM, NE) 
3 First First yes Racer first name 
4 Last Last yes  
5 Year of Birth Year of Birth yes **IMPT: used to set age class 
6 USSA Number USSA Number yes  
7 Sex (Masters or XC) Sex (Masters or XC) yes  
8 Cross Reference 1 Cross Reference 1 yes SRR racer id for entry charges 
9 Cross Reference 2 Cross Reference 2 yes SRR race id for entry charges 
10 USSA Paid Custom 1 optional USSA license current – Y or N 
11 Payment Method Custom 2 optional SRR racer account info 
12 USSA Paid Note Team recomm *** if no masters license 
13 Registration Note Notes or Custom 1/2 optional Note about this race entry 
14 Racer Process Note Notes or Custom 1/2 optional Racer account processing note 
15 <eor> -- -- Unused; ignore 
 
In general, the Split Second field is the same as the column label in the first row of the registrations 
data file. 
 

- Bib is set for divisions which assign permanent bib numbers to their members 
- Club is used for team name by divisions which have some form of team competition 
- the two Cross Reference fields are the “magic tokens” that are used when race entry fee 

charges are made – these are critical to have in the race data file!! 
- the USSA Paid field is set to Y or No based on whether the competitor’s ussa number (if 

known) is listed as current by USSA.  Load into the Custom 1 field as an extra check in the 
competitor data 

- the Payment Method field is an indicator of how the racer’s payment is handled through 
SkiRaceReg.com (usually some form of CC credit card).  Optionally load into the Custom 2 
field. 

- The USSA Paid Note contains ‘***’ when USSA Paid is N, indicating that this competitor 
needs a weekend license or to obtain/renew their Masters competition license. We recommend 
that you load this value into the Split Second Team field so that there is a strong visual 
reminder on the competitors page in Split Second as well as on reports to mark competitors 
with license issues. 

 
Two additional notes fields have been added for 2012 to assist administrators with managing and 
processing race entries.  These are optional values that you can choose to load into the 
Custom1/Custom2 fields or the Notes field if you wish to have these values included in your Split 



Second race data file.  When available, these values will be displayed when reviewing race entries 
from the SkiRaceReg.com Administration page and during post-race processing and review when race 
registration charge transactions are being prepared and submitted. 
 

- the Registration Note field is an administrator’s note about a specific race entry.  This is 
intended to allow special cases to be flagged for a specific race entry.  The registration note is 
displayed with a racer’s billing during race processing. 

-  the Racer Process Note field contains notes from the series administrator about a racer’s 
account on SkiRaceReg.com.  This is intended to help you keep track of special billing cases.  
The racer note is displayed with a racer’s billing during race processing. 

 
After you have set up the import mappings and reviewed in the Preview area, change the Lines to 
ignore choice to 1 so that the labels row in the registrations data file will be ignored and  click Ok to 
import the online competitor entries into your race file. 
 
When prompted “Set Class from YOB?”, say YES!!!  This will set the racer’s age class correctly. 
 
Check the information dialog when the import is done and verify competitors were loaded and no 
duplicates found. 
 
Repeat for each race, so that the downloaded competitor entries from SkiRaceReg.com are loaded into 
the corresponding Split Second race file. 
 
Note: once you have set up the column import mappings, Split Second will remember your choices, so 
once you’ve completing doing the import for the first race you won’t have to repeat the column 
mappings choices each time. 
 
In each race file, you will need to assign a bib number to any competitors imported from the online 
registration system who do not have a permanent bib already assigned.  Ordinarily you will want to 
ensure that the competitor is assigned the same bib for all races. 
 
 
(back to Contents) 



	  

Uploading	  Results	  to	  SkiRaceReg.com	  and	  Post-‐Race	  Payment	  Processing	  
 
At the completion of your event, you will review and post entry fee charge transactions to 
SkiRaceReg.com site by uploading the results data file from each race to the site, reviewing the 
charges for entered competitors to make any desired adjustments, and post the transactions that will 
cuase competitors to be charged for their entries.  Pending charges are processed weekly, customarily 
on Tuesday each week to allow weekend races to be posted by the organizers, and a settlement check 
for the posted charges mailed out on Wednesday. 
 
The standard arrangement is for the weekly settlement check from SkiRaceReg.com to be sent to the 
race series division, which is responsible for disbursements to the race organizer hosting the event.  
However, it is also possible when pre-arranged agreement is made for the check to made sent directly 
to an organizing area. 
 
Posting transactions for charge processing occurs in three steps: generate the results data file from each 
race and upload to SkiRaceReg.com, review the transactions for all racers to make any appropriate 
adjustments to add/remove/change fees to be charged, and post the transactions to the system for 
processing. 
 

Generate Results Data from each Race 
For each race in which competitor entries came in through the online registration system, you will 
generate a results data file from Split Second and upload to SkiRaceReg.com. 
 
Before generating the results data file, verify that you have a USSA race code set on the Header page.  
The men’s race code is used when generating the single results data file containing all competitors. 
 

• Select the Competitors tab; 
• Click the Send SkiData Files button to generate the results data file 
• In the confirmation prompt “Is this being sent to USSA?”, select No to generate the results 

file containing all competitors 
• Choose the option to save to a file – select Specify Path for SkiData File to save 

the file and select your SkiRaceReg Files folder that you created during your setup 
 
Repeat for each race.  Check your SkiRaceReg Files folder when you are done and verify that all races 
were exported to the results data files. 
 
Optional: the generated results data files use the USSA race code as the name of the file.  You may 
wish to modify the file names to add a brief descriptive name to the file so it’s easier to identify the 
races. 
 
 



Upload Results Data from each Race to SkiRaceReg.com 
 
To upload the data from each race, log into the SkiRaceReg.com web site with your RA account.  
Select Races from the choices in the Administration menu at the far right of your window.  For each of 
your races, locate the race in the listing page and click the upload and import link in the Actions 
column (below the registrations link that displays a page showing the competitors and the download 
link that you used to import online entries into your Split Second race files).   
 
In the Race Import page, use the upload race file button to load the results data file for the race from 
your SkiRaceReg Files folder where you placed the files in the preceding step. The Browse button 
allows you to locate and select the results data file on your computer.  After the data file has been 
uploaded to the site, you need to Import the data file to load the transactions. 
 
The Import processing contains checks to ensure that the data file being loaded contains entries for the 
appropriate race – this helps prevent mistakenly posting charges incorrectly.  After verifying the the 
correct data file has been uploaded, the data is imported and the race status is marked as Imported on 
the main Races listing page. 
 
The import checking and transaction loading relies on the cross-reference fields attached to each 
competitor entry which was imported from the online registration system – one value identifies the 
race on the registration system, the other identifies the racer whose account should be charged. The 
system separates competitors who were entered directly by the organizer, as those racers have 
customarily already paid their entry fee directly by check or credit card. 
 

Post-race Review and Invoicing 
 
After the data files for each completed race has been uploaded to SkiRaceReg.com, select the post-
race review and invoicing link at the top of the Admin Races listing page. 
 
All competitors entered in the race who did not come through the online system are listed in the two 
sections at the top of the page.  Each division has its own procedure for how to handle these 
competitors – some wish to add entries into their division series member accounts in order to track 
participants, others simply ignore these races and only track competitors who need to be charged race 
fees.  If you are one of the divisions that ignore these entries, this is a good spot to check to make sure 
that you have some other form of payment for each of the entries in these two sections. 
 
On the third section of the review page you can now review the pending transactions to be charged 
against each competitor who submitted their entry through the online system.  For each competitor, 
you will see an entry for each race in which they were entered. Review each racer and if appropriate 
make any adjustments to their charges. To change the transaction so that it does not charge the racer’s 
credit card, change the drop down box that reads Race Fee to No Transaction.  
 
Administrator processing notes about a racer’s account or a specific race entry are displayed during 
race processing.  A racer processing note can be provided on a racer’s account by the series 
administrator to keep track of special billing cases.  A registration processing note can be made for a 
specific race entry to keep track of any special conditions about a particular race entry. 
 



Some of the processing cases you may need to consider: 
 

• Void charges for a DNS racer who was entered but did not start – the racer is responsible for 
contacting the organizer to request withdrawal and refund of their entry fee after the 
registration deadline has passed (this is typically a day prior to the race). 

• Void charges for a racer whose fees you wish to “comp” (e.g., if one of the organizers staff 
members such as a coach or race crew member competes, the organizer may wish to comp their 
entry fees and not charge the competitor) 

• Add a new transaction for any additional charges or late fees that the racer has incurred. 
 
When you are satisfied that the pending charges are as desired and any special considerations have 
been resolved, press the Set to Process button.  On the next screen, press the Preview Invoices button 
to display a review page where you can perform a final check on the charges that are about to be 
submitted.   
 
If all the charges are as desired, press the Invoice button to post the transactions for processing by the 
system.  Each racer’s credit card will now be processed through the merchant banking system.  This 
step may take some time to process, so be patient with it.  
 
When the invoice processing is completed, you will see a report on all charges that were processed 
with a notation of either “Processing Successful” or “Processing Failed.” At this point you should print 
the page if you want a hard copy report of the charges.  (We recommend performing this step; it’s a 
good idea to keep a record of the invoice processing.) If your browser window does not have a print 
icon hold the Ctrl key down and press the letter p at the same time to invoke the Print operation. 
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